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Chapter 1: Introduction

1.1 What is TracerPlus Wireless Server?

TracerPlus Wireless Server extends the functionality of TracerPlus by giving gives users the
ability to share real-time information over WLAN/ WAN and cellular networks. TracerPlus
Wireless Server connects TracerPlus equipped mobile workers via a wireless network, to a wide
variety of ODBC compliant applications including Access, Oracle and SQL Server among others.

New Features in Version 5.0

Compatible with TracerPlus 5.0

Optimized for TracerPlus SmartConnect

Significant performance improvement in wireless lookup speeds
WWAN connectivity improvements including auto-connect.
Image capture transfer now supported.

Support for 2 database platforms (ADOCE, SQLCE)

Data compression for improved performance.

Consistent with all PTS software, you do not have to be a programmer to use TracerPlus
Wireless Server. Simply create your applications in TracerPlus or TracerPlus Desktop and
connect your database to TracerPlus Wireless Server. In minutes, your entire organization is
connected with up to the minute information using the simple configuration tools.

Highlights Include:

¢ Live Connection to Centralized Enterprise Data

e Decreased PDA Memory Needs

¢ Simple Connection to Most Databases

¢ Real Time Visibility of Mission-Critical Data

e Sample Access Database Included

¢ New Offline batch mode allows wireless batch synchronization

The power of TracerPlus Wireless Server lies in its automatic configuration tool. In minutes, it
automatically configures a wireless connection between TracerPlus enabled terminals and your
host data source. Mapping data is simple; just choose your host database and map your
TracerPlus fields to your host data source fields.

TracerPlus Wireless Server is provided on a trial basis in order to offer businesses the
opportunity to gain hands on experience with the features and advantages of the TracerPlus suite
of applications. You can evaluate TracerPlus Wireless Server at no cost but will need to
periodically request evaluation codes from us. Once you decide to purchase TracerPlus Wireless
Server, a license is available at www.ptshome.com.

TracerPlus Wireless Server supports both TracerPlus Standard and TracerPlus Professional
versions.

1.2 Learning TracerPlus Wireless Server

In order to take full advantage of the abilities of TracerPlus Wireless Server, we strongly
recommend that you first learn the basics of TracerPlus. If you are not a licensed TracerPlus user
and you do not own a PDA with which you can perform a trial evaluation, a thorough read of the
TracerPlus Manual can provide the most crucial information. After you have an understanding of
TracerPlus, we recommend reviewing this manual thoroughly before using TracerPlus Wireless
Server.
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1.3 PTS Support

As a registered TracerPlus Wireless Server user, you receive free e-mail support for 30 days from
the date of purchase. During this period, we are available to answer TracerPlus Wireless Server
and TracerPlus questions as well as general bar code questions. However, we are unable to
support questions regarding your specific wireless network setup, unless that hardware was
supplied by PTS.

At PTS, our goal is to provide our users the tools to capitalize on the efficiencies of bar code data
acquisition and wireless mobility. To contact PTS support, e-mail support@ptshome.com.
Please allow us 24 hours to respond although it is often much faster.

Extended support agreements, including phone support, can also be purchased at
http://www.ptshome.com/support.htm.
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Chapter 2: Installation

This chapter details the steps for installing TracerPlus Wireless Server.

2.1 System Requirements

Windows 98/NT/2000/XP/Vista

Wireless network

20 MB free disk space

ActiveSync version 3.5 or higher for 98/NT/2000/XP users.

Windows Mobile Device Center for Vista Users

A Wireless Device running Windows Mobile, CE, CE.Net, or Pocket PC.
Trial or registered version of TracerPlus 5.0 or higher

ODBC compliant data source

Optional — Microsoft Access

User Knowledge Base Requirements
¢ Basic understanding of networking and wireless networking
e Basic understanding of TracerPlus
e Basic understanding of ODBC and Data Sources

Note: References and instructions relating to ActiveSync in this manual also apply to the
Windows Mobile Device Center on the Vista operating system. Naming procedures of future
versions of the proprietary Windows syncing software is controlled by Microsoft and subject to
change without notice.

2.2 Installation

During the TracerPlus Wireless Server installation, the latest version of TracerPlus can be
installed to your PDA. During this process, you should not experience any loss of data or
sessions. However, we recommend that you backup your data before performing an upgrade
from a previous version. This can be accomplished by executing a File>Export from within
TracerPlus.

Note: Terminals running TracerPlus Wireless can run in either a batch mode or a Wireless
mode.

1. Download TracerPlus Wireless Server from PTS Home.com, TracerPlus.com or
from an authorized PTS reseller.

2. Onyour PC, install TracerPlus Wireless Server by running the downloaded file.

3. Following installation of TracerPlus Wireless Server, you will have the opportunity to
install the newest version of TracerPlus onto your PDA(S).

4. If your terminal is connected via ActiveSync, the latest version of TracerPlus will be
installed. If your terminal(s) are not connected, the new version of TracerPlus will be
installed when the next connection is made and ActiveSync runs.
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2.3 Evaluating TracerPlus Wireless Server

TracerPlus Wireless Server users wishing to evaluate the application before purchasing can do
so by installing the software and activating it in the evaluation mode. In the evaluation mode
TracerPlus Wireless Server is fully functional for a fixed amount of time after an evaluation code
is entered. Once registered, these limitations are removed.

Initially, you are provided with an evaluation code upon the first mobile device connection to
Wireless Server. An evaluation code for TracerPlus Wireless Server can also be requested by
navigating to Tools - Registration and clicking the Request Evaluation Code button located in
the lower right hand corner of the Registration screen.

PTS5 Wireless - Registration E

Registration

A reqgistration code for your PTS Wireless Server allows PDAs
to connect to the zerver. PDAs require either an evaluation
code [gzee below] or a registration code [on each PDA).

PCID Begistration Code
|

* Mot Registered =

Reguest Registration Code

Evaluation

An evaluation code lets you uge PTS Wireless Server for a
limited period of time. and also allows unregistered PDAs to
connect to the server.

E waluation Request

T

Ewaluation Code

Request Evaluation Code....

Torequest an evaluation code, click the button below.
If your computer iz not connected to the Internet, please visit:
hittp: Ay, ptshome. comdproductredirect/ TR EVALREQUEST . php

Request an evaluation code using the "PC 10" and “Evaluation
Request" values above.

Cancel

A web form is presented asking for basic contact information. Fill in the requested information
and click the Submit button. An evaluation code will appear that must be entered in the
Evaluation Code field located in the lower right hand of the Registration screen.

24 Registering TracerPlus Wireless Server

PTS encourages all users who benefit from TracerPlus Wireless Server to register their copy. To
register TracerPlus Wireless Server, we require your PC ID, order number and an e-mail address.
We generate a unique registration code based on this PC ID, so it is important that you send the
PC ID exactly as it appears on the computer.

Note: All terminals connecting to TracerPlus Wireless Server must also have a registered
license of TracerPlus with the Wireless Plug-in enabled.
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How to Register:

1. Locate the order number used to purchase TracerPlus Wireless Server as it will be
needed to register the software. If you have not yet purchased TracerPlus Wireless
Server, go to the PTS website http://www.ptshome.com to do so.

2. In TracerPlus Wireless Server, click on Tools>Registration.

3. Click the Request Registration Code button.

PTS Wireless - Registration E

Reqistration

A registration code for your PTS Wireless Server allows PDAs
to connect to the zerver. PDAs require either an evaluation
code [see below] or a registration code [on each PDA).

FCID Begizstration Code
|
= Mot Registered =
Request Registration Code
Evaluation

An evaluation code lets you use PTS Wireless Server for a
limited penod of time, and also allows unregqistered PDAs to
connect to the server.

Evaluation Request Ewaluation Code

e

Request Evaluation Code...

Torequest an evaluation code, click the button below.

IF your computer is not connected ta the Intemet, please vizit:

http: A www ptshome. comdproductredirect/TPW EVALREGUEST.php
Fequest an evaluation code using the "PC 1D and "E valuation
Reguest" values above.

Cancel

4. A PTS web page is presented, prompting you for order specific information.
Complete this form and be sure to include the correct Order Number and the correct
PC ID.

5. Once this step is completed, your registration code is e-mailed to the address
provided. This process usually takes one hour but we ask that you allow one
business day in the event of heavy traffic or any other delay.

6. Once you receive your registration code, follow the instructions in Section 2.5 for
entering the code into TracerPlus Wireless Server.
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25 Entering your Registration Code

1. Goto Tools = Registration and enter the Registration code in the Registration

Code field.
PTS Wireless - Registration @
Registration

A registration code for your PTS Wireless Server allows PDAs
to connect to the server. PDAz require either an evaluation
code [see below] or a registration code [on each PDA).

PCID Registration Code

el

* Mot Registered =

Request Registration Code

Evaluation

An evaluation code lets you use PTS Wireless Server for a
limited period of ime, and also allows unregistered PDAs to
connect to the server.

Ewvaluation Request Ewaluation Code

et

Reguest Evaluation Code...

To request an evaluation code, click the button belaw.

If your computer iz not connected to the Intemet, please visit:

hittp: A prshome. comdproductredirect/ TP EVALREQUEST. php
Reguest an evaluation code using the "PC ID" and “Evaluation
Reguest" valuesz above.

Cancel

2. Click the OK Button.

3. If all information submitted is correct a Thank You for Registering TracerPlus
Wireless Server message should appear.

2.6 Un-installing TracerPlus Wireless Server

In the unlikely event that you would like to remove TracerPlus Wireless Server follow these
simple instructions.

1. From the Windows Start menu, Navigate to Control Panel.
2. Select PTS TracerPlus Wireless Server and click Remove.
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Chapter 3: Modes of Wireless Operation

Chapter 3: Connecting a PDA to a Wireless Network

Wireless PDAs can easily be configured to connect a mobile worker or workforce to a pre-existing
wireless network or a single computer with a wireless network card.

3.1 Adding TracerPlus Wireless Server to an Existing Network

Your PDA can be connected to an existing network in one of two ways; the preferred method is
with a dynamic IP address using DHCP explained in Section 3.1.1. If you do not have DHCP
enabled or your IT department requires a static IP address, refer to details in Section 3.1.2.

Note: Microsoft has reserved the right to update utility names such as Mobile Companion. As a
result, the specific step by step instructions that follow will vary depending upon which version of
Windows Mobile is installed. Overall processes remain the same.

3.1.1 Connect PDA to your wireless network with a dynamic IP address using DHCP

1. Onthe Home screen of the PDA, click the Mobile Companion (or Wireless
Companion) icon in the bottom right hand corner and choose Find WLANSs.

¥ s o ra
. |5ta_rt For Ve o€ (I

<] Fridér
February

il Phone off ﬂ
; &= wireless Status
& wireless Diagnostics

Tap here ko
Mo unread mess

Mo tasks

B3 mManage Profiles
I Mo upcoming ap - s

B2 Options

ocker

BT Dizable Radio
Cancel Menu

» Exit

Contacks

Screen Displaying Windows Mobile 5.0
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Chapter 3: Modes of Wireless Operation

2. This should bring up a list of Available WLAN Networks.
3. Click and Hold a network, then tap Connect.

/ & | Find WLANs

WLAMN Met, ., | Metwark Type | Channel

£ S a0z.11{g)
: LConnect by

(o)

1 (2412 MHz)
& (2437 MHz)
& (2437 MHz)

4. This will bring up a Profile Entry window. Select Next and configure the settings as
appropriate. Select Finish when done.

%p'rg Profile

F‘TS Profile 10 MHz)

wu:ue Mame: | | MHz )
ESSID:[PTS |

5. A network connection should now exist.

6. To verify you are connected to the network, refer to Section 3.1.3.

TracerPlus Wireless Server v5.0
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Chapter 3: Modes of Wireless Operation

3.1.2 Connect PDA to your existing wireless network with a static IP address

If you are unable to connect using DHCP, as described in Section 3.1.1, you can use a static IP
address.

1. Onthe Home screen of the PDA, tap the Mobile Companion icon located in the
bottom right hand corner and choose Find WLANS.

For T 6@

L <] Frida;f
February 04, 20K

Phone off
Wi-Fi: Metwark

% Wireless Status
qg Wireless Diagnostics
" Find WLARMs

B3 manage Profiles

Tap here ko sek

Mo unread mess

Mo kasks

I Mo upcoming ap
ES Options

{0 Disable Radio
Canicel Menu

= Exit

Contacks

2. Alist of Available WLAN Networks should be generated.
3. Click and hold a network and tap Connect.

/ ¢ | Find WLANs B Too 45 ok

LA Met. .. | Mebwork Type | Channel
a02.11(g) 1 (2412 MHz)
Connect [y & (2437 MHz)
(g & (2437 MHz)
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Chapter 3: Modes of Wireless Operation

4. From the Profile Entry screen, navigate to the IP Entry Screen.

% TS Profile

[BrTs
W0

Prafile 10

Mame: | |

ESSID:[PT3 |

[Br1s
W0

% = RrGiile

IP Address Entry:

DHCP
DHCP

|=:<:=:ﬁack || mext:e-:e-:e-|

MHz)
MHz)

TracerPlus Wireless Server v5.0
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Chapter 3: Modes of Wireless Operation

6. Enter the IP Address and Subnet information for your network. To configure a Default

Gateway, DNS Server or WINS Server check the Advanced box before clicking

Next. Select Finish when done.

- | Find WLANS

e
BEpTs Profile En

|:IF'T5 IF Address Entry; ———— [ MHz)
W.:,E IP Address: MHzZ)

|192.165.4.103 |
Subnet Mask:
|255.255.255.0 |

D Advanced

|=:=:=:§au:k || mext:::b::|

7. To verify you are connected to your network, perform the Ping Test outlined below.

3.1.3 Ping Test

1. Go to the Home screen and tap the Mobile Companion icon and select Wireless

Diagnostics.

Phone ofF
YWi-Fi: Mek

HE# Find WLANS
B3

I Mo upcoming ap = Manage Gyl
B2 Options

== |_og Onfoff
€0 Dizablz Radio

Cancel Menu

Cevice unlocke:

",Tap here to sigr

= Exit

Contacks

TracerPlus Wireless Server v5.0
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Chapter 3: Modes of Wireless Operation

2. Select 1) ICMP Ping.

;‘. | wireless Diagnostics F+ T, 4¢ ok

WWireless Diagnostics
HJICMPPRing
231 Trace Rouke
3 Enown APs

4) Quit

3. Enter a valid ID Address and select Start Test.

j‘. | Wire.less Diagnostics '.i"_-b Yy 45 ok

1) ICMP Ping =
IF: |192.153.4.1|:|5| v| [ start Test |

Size: AP 00:15:70:25:8C:5C
Sigrial (dBm):; | EEE

Maise (dBnm): |

MR, (dEY: B =0

Tokal Tax: 0

Total R

Laosk:

Last RT Time {ms);

g BT Time (ms;

Min BT Time {ms):

Max BT Time {ms);

% 54 Mbps:

% 48 Mbps:

% 36 Mbps: 1

S #d fhns:
i

[+ ]

4. If a successful connection is established, a green bar will appear corresponding to
the specific speed of your connection.
5. Tap the Back Arrow, then Select 4) Quit.

Note: If you have not setup your wireless router or access point please consult your device’'s
user manual.

TracerPlus Wireless Server v5.0
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Chapter 3: Modes of Wireless Operation

3.2 Operating TracerPlus Wireless Server in Adhoc Mode

TracerPlus can be operated from PCs and Laptops that are not members of a network by setting
them up in Adhoc mode. To accomplish this, you simply need a wireless network card.

3.2.1 Configure the PC or laptop’s TCP/IP Settings

1. Rightclick My Network Places and select Properties.
2. Right click your wireless adapter and select Properties.
3. Double click Internet Protocol (TCP/IP).

L Wireless Network Connection Properties E”‘S__q

General ! Wireless Mebworks E..-’-'-.u:h-'anu:eu:l5

Connect uzing:

BB Dol wirless WLAN 1350 WLAN Mi

Thiz connection uzes the following tems:

E Client for Microzoft Nebworks
.@ File and Printer Sharing for Microzoft Hebworks
.QE!DS Packet S cheduler

r [nternet Protocal [TCRAR]
Iztall... Irinztall
Description

Transmizzion Control Protocol/linternet Protocal. The default
wide area netwark, protocol that provides communication
acrozz diverse interconnected networks,

[] Show icon in natification area when connected
Matify me when this connection haz limited ar no connectivity

QF. ] [ Cancel

TracerPlus Wireless Server v5.0
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Chapter 3: Modes of Wireless Operation

4. Select Use the following IP address and enter an IP. Ex: 192.168.1.10
5. Set Subnet Mask to 255.255.255.0

Internet Protocol (TCP/IP) Properties

General |

Y'ou zan get [P zettings aszigned automatically if vour network, zupports
thiz capability. Otherwize, pou need to ask vour network adminiztrator for
the appropriate 1P zettings.

{7 Obtain an IP address autamatically
{#) Usze the following IP address:

IP address: 192168 1 . 10 |
|
|

Subnet mazk: | 285 2RR . ZRR . 0

Default gateway: |

{#) Usze the tollowing DMNS server addresses:
Freferred DMS server: | . . . |

Alternate DNS server: | . . . |

[ s J[ Cancel ]

6. Click the OK to exit.
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Chapter 3: Modes of Wireless Operation

3.2.2 Setup the Ad Hoc connection on your PC or Laptop

1. Rightclick My Network Places and right click your Wireless Adapter and click
Properties.

L Wireless Network Connection Properties E”’)Z|

General | \wirsless Networks | Advanced |

Caonnect uzing:

ED Dell'wireless WLAN 1350 WLAN Mi

Thiz connection uses the following items:

% Clignt far Micrazaft Metwarks
.@ File and Printer Sharing for Microsoft Mebwarks
81 05 Packet Scheduler

Internet Protocaol [TCRAAR]
[ Imstall... ] Irninztall [ Propertiez
Dezcription

Tranzmigzion Contral Protocol/ nternet Protocol. The default
vide area nebwork protocal that provides communication
acrozz diverse interconnected nebwarks.

] Show icon in notification area when connected
Hatify me when thiz connection has limited ar no connectivibg

] ] [ Cancel

TracerPlus Wireless Server v5.0
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Chapter 3: Modes of Wireless Operation

2. Select the Wireless Networks tab.

-+ Wireless Network Connection Properties E|[E|

Ilze Windows to configure my wirelezs network, zettings

Ayeailable network g

To connect b, dizconnect from, or find aut mare information
about wireless netwarks inrange, click the button below.

Wigw Wireless Mebworkz

Preferred networks:
Automatically connect to available networks in the order hizted
belo:

B METGEAR [Automatic) ~ kave up
1 PTS_CAL [Manual)

A chuif [utomatic) i

A horn [Butomatic) R

[ Add... H Remove ][ Froperties ]

Learn about setting up wirsless network

configuration,

[ Ok ][ Cancel ]

3. Click the Advanced button located in the lower right hand corner of the screen.
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Chapter 3: Modes of Wireless Operation

4. Select Computer-to-computer (ad hoc) networks only.
5. Click Close to exit.

Advanced

Metworks to access
(" Arw available network, [access point prefered
() Acoess point [infrastucture] networks only

(%) Computer-to-computer [ad hoo) netwarks only

[ ] Automatically connect ta non-prefered networks

Cloze

6. Inthe Preferred networks area of the screen, click the Add button.

-+ Wireless Network Connection Properties E|[E|

Ilze Windows to configure my wirelezs network, zettings

Ayeailable network g

To connect to, dizconnect from, or find aut mare information
about wireless netwarks inrange, click the button below.

Wigw wireless Mebworks

Freferred network
Automatically connect to available networks in the order lizted
below:

| METGEAR [Automatic) ~ kiove up
1 PT5_CaL [Manuall

A chuifi [utomatic] B

A horn [Automatic)

ki
[ Add... ] [ Remove ] [ Properties ]
tz:;in jrlfua?gfettinq up wireless network,
k. ] [ Cancel ]
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Chapter 3: Modes of Wireless Operation

7. Enter a Network name (SSID) for this connection. (i.e. PTSWireless).
8. Inthe Wireless network key area set Network Authentication to Open.

9. Set Data encryption to WEP or you can disable it, if necessary. In this example, it is

set to Disable.
10. Select OK and OK again to exit.

Wireless network properties

Agsaciation | Authentication | Connection |

Metwark name [SSI0); | PT5Wireless |

Wireless netwark key

Thiz network requires a key for the following:

Metwork Authentication: | Open w |
D ata encryption: |WEF‘ v|

F.ew index [advanced) 1

The kev iz provided for me autamatically

This = 5 ~ame AT I [ad kol B L raleas
[his iz a computer-to-computer [ad hoc] network; wirsless

access pointz are nat Lzed

[ ] ][ Cancel J

11. You should now see your wireless connection as shared.

TracerPlus Wireless Server v5.0
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Chapter 3: Modes of Wireless Operation

3.2.3 Connect to your PC or laptop from the handheld

1. Inthe bottom right hand corner of the Home screen click the Mobile Companion
icon and select Find WLANS.

“|Mobile Companion gF < 2:22

) Tuesday, January 18, 2005
Tap here ko set owner information
Mo unread mes

Mo tasks

Status

WLAN Profiles
Find WLANs
Options

MNew @

Screen Displaying Windows Mobile 2003

2. PTSWireless will be listed in Available WLAN Networks.
3. Tap the Connect button.

7| Mobile Companion [} £ 2:23 @

fevailable WLAN Metwarks
PTS_CAL Conneck

................................ |

1] [ [ |» Close |

TracerPlus Wireless Server v5.0

21



4. Configure Authentication and Encryption if necessary.

3

: /5 |Mobile Companion &t < 2:27 9

- Wireless LAN Mode
Profile Mame ;

|F'TSWireIess |
02,11 ESSID:
|PTSWireIess |

Operating mode:
|.|:-..:|-H.:..: - |

Counkry: |LISF'. v|

|:| Long preamble
Channel Mumber: |10 *

Maode | &uthentication | Encryption | IPCol 4]k
|~

5. Tap the IP Configuration tab and select Static from the drop down menu.

- IP Configuration

IP Address:  [192.168.1.11
subnet Mask: |255.255.255_EI

DNS: |

|
|
Gakeway: | |
|
|

WINS: |

Authentication | Encryption | IF Canfig | F‘t| 11 F
|-

In the IP Address field, enter 192.168.1.11.
In the Subnet Mask field, enter 255.255.255.0.
Tap OK to connect.

©o~N

right hand corner and selecting Status.

TracerPlus Wireless Server v5.0

You can verify your connection by clicking the Mobile Companion icon in the bottom
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Chapter 3: Modes of Wireless Operation

*|Mobile Companion ¥ 4<

Tuesday, January 18, 2005

owiner information

Status

WLAN Profiles
Find WLANs
Options

r Known Peers
Feers MAC | Povwer Mode | Tr
00:0B:7Dn0ASEEZ CAM 11
1 | i [ [ »
Info | IP Status | Peers |
B\~
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Chapter 4: Configuring TracerPlus Wireless Server

4.1 Setting up Wireless Server

1. Go to Wireless Server on your PC.

@ TracerPlus 5 »

@ TracerPlus Desktop

rILﬂ TracerPlus W E Documentation - \Wireless Server
() ODEC Lirk 5 >

PTS Home Page

g PTD Wireless Server

@1 PDA Installer

L"ﬂ Registration Info
El] Wiew Sample Data

2. Goto Application Settings

£ PT5S - TracerPlus Wireless Server - [Client List]

File Server Wiew Tools Help

%Main&reen B ﬁ

:ﬁ QODEC Configuration
AN

b erver Monitor Client M onitor

m Application Settings

Client: JSmith@192.168_4.105

Mame:  192.168.4.1085 Model: M/
Description:, - Oper. Sys:  Pocket PC
4= Usemame:  JSmith Software:  TracerPlus

@ E it Senial ¥ 026E3400-0D41D255 Wersion: 1.6.1
Feg Code: B72412293

Status:
Meszages:  BosBi Seszion:  #1: Inventor Track
Butes:  17220/635i Plugin:  PPTP_P* ver. 1.6.1
Connect Time:  Jul-12 18:16:05 Ses Reg:  sesssssss
Last Message:  Jul-1218:16:07 ODBC DSM:  PTS_TracePluswirelesz

ODBC Table:  Sessiondl

Juk1218:15:23 Server PC-116-691-6509 iz UMREGISTERED. Plzasze visit www.ptzhame, com o register.
Juk12 18:15:23 Evaluation activated, expires 7/12/2005 10:00:00 P

Jul1218:16:05 Disconnect from HHH

Juk1218:16:05 Connect fram 192168 4105 ()

Jul1218:16:06 JSmith(@192.168.4.105 open Session0 [Inventary Track]

Connected clients: 1 Server enabled on 192,168.4,16:4402

TracerPlus Wireless Server v5.0
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Chapter 4: Configuring TracerPlus Wireless Server

3. Modify Application Settings if necessary. Application Settings are pre-set to
defaults as seen below.

4. Modify Server Settings, Network Settings, and Logging Settings if necessary.

PTS - TracerPlus Wireless Server - [Application Settings]

File Server Tools Help

tain Screen

ODBC Configuration

Application Settings

Nd@le

(=1 DataViewer

t

u
an

i Exit

I

Connected dients: 0

Server Settings

Server Mame

|F'TS Wireless Server

Dizabled Meszage

[ Server Enabled

COX

|Wire|ess zerver iz not curmently enabled.

Metwork Settings
Server IP Address W Enable Encoding

192.168.4.16

Logging Settings

LogFile [~ “erbose Logging

Server Port Humber

4402 Use Default

|D APTSWirelezsLog, tat

Wiew Logfile...

Clear Logfile. .. |

Server enabled on 192, 168.4, 16:4402

I~

5. Click Save Settings.

PC or laptop.

Note: Confirm that the IP address appearing in the Server IP Address field corresponds to your

TracerPlus Wireless Server v5.0
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4.2 Handheld Configuration

1. Open TracerPlus on your PDA.
2. Select the Configure Tab and choose Wireless Settings.

% B0 <
TrEeEiPius
Configure | Data Entry | iew Data |

n o

}"’ I PTEI TracerPlus

Session Field Prirters
Settings Settings
ET:} « ,,g%ﬁ.
Wireless Passwords
Settings

Last Sync: nfa
File Options Admin Help O

3. Select the Session matching the current session being configured in Wireless
Server.

For Vo <

j"’ | PTSI TracerPlus

REpair Order Wireless

[ ] Enakled
Haost address: | |

Port:

POA MickMarne

|

Done

File Options Admin Help

4. Check Enabled.
5. Enter Server IP Address in the Host Address. Enter the Port and the PDA
NickName.
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Chapter 4: Configuring TracerPlus Wireless Server

6. To test your connection, Tap the Connect button.

Enabled
Host Address: |192.1E|B.4.12 |

Port:

PO MickMNarme
Your PDA Mame Herd] |

Connect <

Done

File Options Admin Help

7. Atthis time you should see the Connected to: message as seen below.

Connected to:

Ef 192,1658.4.12
Host Joe's Wireless Server
05 5,0,0,335

PO MickMarne
Your PDA MAME Here |

Done

File Options Admin Help

Note: If you should receive an error after tapping Connect, please refer to Chapter 6 for
troubleshooting suggestions.

TracerPlus Wireless Server is pre-configured with a sample database connection. After the
setup process is successfully completed, data should transmit between the PDA and the
sample database. Please proceed to Section 4.5 to learn how to test your PTS wireless
connection.
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4.3 Connecting to an Existing Database

Double Click the Administrative Tools Icon.
Double click the Data Sources (ODBC) icon.
The ODBC Data Source Administrator window will appear.

el

£ ODBC Data Source Administrator

Uzer DSN | Spstem DSN] File DSN] Driveral Tracing] Connection F'ou:ulingl dbot l

Uszer Data Sources:

| Driver | Add...
icrosoft dB aze Diriver [*.dbf]

Microsoft Excel Driver [7.@lz] Remove
M5 Access Database  Microzoft Access Driver [*.mdb)
Yigual FouPro Databaze  Microsoft YWisual FoxPro Driver Configure. .
Yizual FoxPro T ables b icrogzoft Yizual FoxPro Driver

i

An ODEC Usger data source gtores information about how to connect to
the indicated data provider. & User data zource iz anly visible to you,
and can only be uzed on the current machine.

k. | Cancel Help

TracerPlus Wireless Server v5.0

From your PC Start menu navigate to Start->Settings=>Control Panel.
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Chapter 4: Configuring TracerPlus Wireless Server

5. Select the System DSN tab and you should see the PTS TracerPlus Sample DSN
listed with System Data Sources.

€71 ODBC Data Source Administrator,

lger DSN  Swstern DSH lFiIe DSN] Drivers] Tracing] Connection F'u:u:nlingl About ]

Swyztem Data Sources:

M arne | Driver | Add...
Anaztd Microzoft Access Driver [ mdb]
BN R Microzoft Access Driver [ mdb] RBemove
Triokd otars icrosoft Access Driver [*.mdb)

i

LConfigure. ..

An ODBC System data source stores infarmation about how to cannect o
the indicated data provider. & System data zource 13 vizible to all users
on this machine, including MT services.

Ok | Cancel Help

6. Select PTS TracerPlus Sample and click Configure.
7. This will present the ODBC Microsoft Access Setup window.

ODBC Microsoft Access Setup

Data Source Mame: |F'TS TracerPlus Sample ] |
Description: |EIDEI:Link Dirivver
Cancel
Database
Database: CAAODEC LinkBWDatahTracerPlus mdb Help
Select,.. ‘ LCreate... | RBepair... Compact... |
Advanced...

Syztern Databaze

s Mone

" Database:

[Boancobs.

I

Optiongy»
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8. Inthe Database section click the Select button to bring up the Select Database
window.

Select Database

D atabase Mame Directories:
TracerPluz.mdb b Sprghodbe link5hdata
Cancel
TracerPlus. mdb =t
== Program Filzs
= PTs Help
[= ODBC Lirk5 B e Tl
Diat —
& Data [ Exclusive
Ligt Filez of Tepe: Dinives:
|.-'1'u:cess Databazes [“.mj | == ﬂ Metwaork...

9. Under Drives: select the hard drive where your database is located.

10. Under Directories navigate to the folder containing your database.

11. Once you are in the directory you should see your database appear in the Database
Name window.

12. Select the database and click OK.

13. Click OK and OK to close the remaining open windows.

14. The PTS TracerPlus Sample DSN is now configured to point to your database.

15. Proceed to Section 4.4 to configure your Sessions.
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4.4 Session Settings

The ODBC Configuration form is opened by selecting the ODBC Configuration
’E icon, located in the left hand column on the Main Screen. Configuring this form

properly enables TracerPlus Sessions to connect to ODBC Data Sources.

PTS - TracerPlus Wireless Server - [ODBC Configuration]

File Server Tools Help
|
Main Screen
5 Session 1 Enabled v
Session 3 M ame:
NDBE Configuration | | Session 4 [Session 1
Session §
Session B ODBC data source settings Field mapping and advanced options
Session 7 =
Figld Mapping l Update Options ]
i 6 Session 8
m Application Settings Cesiond Select your ODBC data source EAEE T =
Session 10
= Session 11
. Session 12 D — Field02 Field2
| Data Viewer gessmn 13 2 EERil sl Field03 Field3
== "
o Session 15 F!e\dﬂﬂi Figldd %
£a Session 16 Database Lsemame Figld05 Fields
= Erit Session 17 l— Field& Fieldg @
= oE= onyle Fisidll7 Field?
Session 19 = Py
Session 20 Database Password Field08 Fiedd® =]
Session 21 Field03 Figldd 3@
Sesionie Fied10 Field10
Session 23 =
Session 24 Figld11 Field11
Session 25 Table ReadOnly [ Field12 Field12
Session 26 = i
= [session0t =] Field13 Field13
Session 20 F!shﬂ 4 Field14
Session 29 Koy Fiekd Field15 Field15
Session 30 Field1E Field18
Session 31 |ID j 5
Session 12 . Figld17 Figld17
Field18 Field18
Figld13 Field13
Figld20 Field20
Figld21 Field21
Figld22 Field22
Figld23 Field23
Figld24 Field24
Figld25 Field25
Figld26 Field2g
Figld27 Field2?
Figld28 Field28 b
< »
Connected dients: 0 Server enabled on 192,168, 4, 16:4402

The first step in configuring TracerPlus Wireless Server is choosing the TracerPlus Session the
Data Source will connect to. Select the Session from the Session List, located in the left hand
column of the configuration screen and configure the additional settings described below.

Enabled Checkbox

The Enabled checkbox allows the user to turn a session on or off. When a session is enabled it
will allow connections from the device. If the session is not enabled, it will prohibit the connected
device from accessing the session and no new data is transferred.

Name
The Name field allows the user to change the name of the selected Session. The designated
Name will appear next to the Session number for easy reference.

ODBC Data Source Settings
After the TracerPlus Session has been selected, named and enabled the user must then
complete the fields in the ODBC Data Source Settings area.

DSN

Select the Data Source Name (DSN) in this field. The drop down list will list all the currently
configured DSNs on your system.
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Note: You can create/modify DSN configurations by using the Control Panel applet
called "ODBC Data Sources" or "Data Sources (ODBC)". You may find this under
Control Panel - Administrative Tools, depending on your operating system version.

TracerPlus Wireless Server creates a sample DSN called "PTS TracerPlus Sample”,
which is pre-configured to connect to the included Microsoft Access database. You
can modify this DSN for your own needs, or create a new one.

ol

DSN Refresh Button
Click the DSN Refresh button at anytime to refresh the DSN drop down list. Use this if the DSN
list is changed while TracerPlus Wireless Server is running.

Database User Name

A User Name is required by some databases in order for ODBC to connect. The ODBC
configured database User Name can be entered in this space. TracerPlus Access Database and
many others do not require a User Name so leaving it blank is acceptable.

Database Password

A Password is required by many databases for ODBC to connect. The ODBC configured
database Password can be entered in this space. TracerPlus Access Database and many
others do not require a Password so leaving it blank is acceptable.

Read Only Checkbox
The Read Only checkbox restricts the mobile worker’s editing abilities for the session. This is
especially useful in providing references in the field.

Table

After the ODBC Data Source is selected the appropriate table must be selected. Choose the
Table you intend to sync data with. The dropdown list will list all the tables within the selected
DSN.

o

Table Refresh Button
Use the Refresh button next to the table drop down to refresh this list. Use this if the tables in the
data source have changed while TracerPlus Wireless Server is running.

Key Field
The Key Field is required. Select the primary key of your database from the drop down menu.
The drop down menu will list all available fields in the selected data source.

ol

Key Field Refresh Button
Use the Refresh button next to the Key Field drop down to refresh this list. Use this if the table
structure of the selected table has changed while TracerPlus Wireless Server is running.

Update Options Tab

Use the Update Options tab to set options for wireless signature transfers. A screenshot of this
tab is below.

TracerPlus Wireless Server v5.0 32



PTS - TracerPlus Wireless Server - [ODBC Configuration]

File Server Took Help

Save Settings
Main Sereen

@ Session 1 Enabled |+
Session 2
Session 3 Mame:
ODBC Configuration | | Session 4 Session 1
Session b
Session b ODBC dats source settings Field mapping and advanced options
Session 7 = 5
Application Seffings || 2255 & Sel FEEE et | W e
A Session 0 elect your ODBC dats source PC Settings
Session 10 ol i
= I Session 11 CIfEE
. Session 12
mn Data Viewer Session 13
Session 14
Session 15
G Session 16 Database Usemame
Ay * Euit Session 17
= Session 18
Session 19
Session 20 Database Passward
Session 21
Session 22
Session 23
Session 24
Session 25 Table Read Only [
Session 26 ™
Session 27 [Sessizntt [=]
Session 28
Session 29 s
Key Field
Session 30
Session 31 |\D j
Session 32
Connected dients: 0 Server enabled on 192. 168.4.16:4402

Transfer Signatures as OLE Objects

This option allows any signatures captured from the mobile device to be transferred as an
embedded OLE object to the mapped PC field for this session. This setting is only relevant if the
mapped field is an OLE or BLOB type field. If the field mapped to a signature is a standard text
field, this setting is ignored.

Signature transfer options
Signature capture is a feature available in TracerPlus Professional. There are currently 3 ways to
transfer signatures from your mobile device to your PC via TracerPlus Wireless Server.

By reference

If you map a TracerPlus signature field to a Standard Text or String field in your
database, this signature is transferred to your PC “by reference”. This method transfers a
.BMP image file containing the signature to your PC. This file is created with an
automatically generated unique filename based on the specific variables at the time of
capture. This name is also written to the mapped field in your ODBC data table for easy
access after the transfer is complete. The default path for these .BMP files following
transfer is C:\Program Files\PTS\TracerPlus Wireless Server 5\Data\Bin.

As raw data

If you map a TracerPlus signature field to a BLOB or Memo field in your database, the
signature data is transferred to that field as a raw data bitmap by default. The contents of
this field will contain the same information as a standard generated bitmap file but it is
contained (embedded) directly in your database. This is useful for many databases and
is the required method in some cases when these signatures are used in a generated
report or other means of displaying the data. This tends to vary per database application
or report generation software.
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As an OLE Object

Similar to a raw data transfer, a TracerPlus signature field can be transferred to a BLOB
or Memo field as an Embedded OLE object. Like a raw data transfer, some database
applications and/or report generators prefer images to be stored/embedded in a database
as an identifiable, embedded OLE object. Microsoft Access is a good example of this.

Image transfer options

Image capture is a feature available in TracerPlus Professional with the latest TracerPlus version
5.0. There are currently 2 ways to transfer images from your mobile device to your PC via
TracerPlus Wireless Server.

4.5

By reference

If you map a TracerPlus image field to a Standard Text or String field in your database,
this image is transferred to your PC “by reference”. This method transfers a .JPG image
file containing the image to your PC. This file is created with an automatically generated
unigue filename based on the specific variables at the time of capture. This name is also
written to the mapped field in your ODBC data table for easy access after the transfer is
complete. The default path for these .JPG files following transfer is C:\Program
Files\PTS\TracerPlus Wireless Server 5\Data\Bin.

As raw data

If you map a TracerPlus Image field to a BLOB or Memo field in your database, the
image data is transferred to that field as raw data. The contents of this field will contain
the same information as a standard generated image file (jpeg) but it is contained
(embedded) directly in your database. This is useful for many databases and is the
required method in some cases when these images are used in a generated report or
other means of displaying the data. This tends to vary per database application or report
generation software.

Test Connection

To test your connection simply begin collecting data in TracerPlus, you should be able to view
your data from Tools - Database Viewer as discussed in Chapter 5.
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5.1 Database Viewer
= Select the Data Viewer button from the Main Screen to view, edit, and filter
Session data. Using the Session drop down list in the top left you can switch
i between the different sessions and view the table data.
[Session 1 L AV LEDRATHRS | T | A A
7 Fieldl  |Field2  [Fied3  |Feldd  |FieldS  [Fields  |Field?  [Finkdd  [Fieidd  |Fieldi0 [Fiekd11 [Feldi2 [Fiek ~
4
| £ »
Database: PTS_TracerPhus_PPC Table: Sassionl Rowes: O

The Database Viewer displays the ODBC Data Source data as defined by the Session Settings
and the DSN connection for that session.

Data Viewer Toolbar

AV LCDE LSRG T]|OGM | &K
F T

* *
Table Mavigation Table Editing Filter Font/ Column Size

Table Navigation
Use these buttons to move one cell in the desired direction. (From left to right) move one
cell up, move one cell down, move one cell left, and move one cell right.

Table Editing

These buttons allow the user to edit records in the table. (From left to right) edit field,
insert new records into the table, commit changes, delete records from the table, and
refresh the table.
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Filter

This button allows the user to filter the table. When selected a prompt is displayed to
enter the filtering criteria. When a filter is set the current filter criteria and number of rows
is displayed in the status bar at the top of the data viewer. To remove the filter, click the
filter button again or select Remove.

Filter Status Bar

Current filker: |[|D] »>"34" Hemuve| E dit |

When a filter is set, the Filter Status Bar is displayed at the top of the data
viewer. The Filter Status Bar displays the currently set filter. From the filter
status bar you can remove the current filter or Edit the current filter. When
Remove is selected, the filter is removed and the data is presented again with no
filter applied. When Edit is selected the filter prompt is displayed allowing the
user to change the filter. When finished, the new filter is displayed in the Filter
Status Bar.

Font/Column Size

Use these buttons to change the data viewer to your preferences. (From left to right)
Increase column width, decrease column width, increase data font size, and decrease
data font size.
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5.2 Logging Window

The Logging Window displays TracerPlus Wireless Server activity. This window can be
disabled by selecting View—>Log Info>Show. Messages sent to the window include the
following:

¢ When the server is enabled or disabled.

e When a PDA in the field connects or disconnects.

e Error Messages received from the Data Source.

e Registration Status.

53 Detail Monitor

The Detail Monitor displays information regarding the Wireless Server and the selected PDA
from the connected PDA client list. You can hide the Detail Monitor by clicking View->Detail
Monitor or selecting the Detail Monitor icon from the toolbar.

Server Monitor

The Server Monitor tab displays the TracerPlus Wireless Server version, the total number of
PDAs connected, the port the TracerPlus Wireless Server is running on, and location of the
server’s configuration file and log file.

Server Momitor Chient Monitor ]
Server
Mame: PTS Wireless Server Start Time:  Jul-05 13:25:55
Wersion:  2.0.0.1 Total Bytes:  35430/939i
Server Port: 4402 Total Clients: 1

Config. File:  D:APTS'cwvs_repozsitonieshdeveloprmenthProjectzWirelezsS erverh P TSWirelezs ini
Log File:  D:APTShews repogitoneshdevelopmenthProjects\wirelessS ervertPT SWireleszl og. bt

TracerPlus Wireless Server v5.0
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Client Monitor

By selecting a client in the client list, you can view the information for that client in the Client

Monitor. This includes the name, model of the PDA, operating system, username, version of
TracerPlus, Serial # (Device ID) of the PDA, and the registration code if the PDA has a valid

registration of TracerPlus Wireless.

The Status section shows information regarding the messages sent and received from the PDA
and the ODBC data source which TracerPlus Wireless Server is connected to.

Server Monitor Client Monitor l

Client: PDAT1E192.168.4.158

Mame: 192168.4.158 Model:  MAA
Description: - Oper. Sps: Pocket PC
Username:  PDAT Software:  TracePlus
Serial #:  03322B00-CA44DEF3 Yersion:  5.0.0
Feg Code: -
Status:
Messages:  20/2 Sesszion; -
Bytez:  8920/300i Flugir: -
Connect Time:  Jan-21 1216:46 Ses Reg: -
Last Message: Jan-21 1271646 ODBCDSH: -
ODBC Table: -
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Chapter 6: Troubleshooting

In this chapter, some of the more common issues you may run into when configuring your
TracerPlus wireless environment are discussed. This is not a complete list, but may be helpful in
resolving the more common issues. If this list does not contain an answer to your issue please e-
mail the PTS Technical Support group. If it is determined that the issue is related to your internal
network configuration, PTS may not be able to help. In this case, you would need to speak to
your network administrator to resolve the issue.

6.1 PDA Wireless Network Connection Issues

If you are unable to connect your PDA to your network via a wireless connection, this is
most likely a network configuration issue specific to your network. Review the settings
and procedures in Chapter 3 to see if you can resolve the issue. If not, you may have to
contact your network administrator for assistance.

6.2 PDA to TracerPlus Wireless Server Connection Issues

If you are unable to connect your PDA to TracerPlus Wireless Server, review the items
below to see if any suggestions resolve the issue. If none of these issues appear to
resolve the issue, contact the PTS Technical Support group for assistance.

- Verify that the server is running on a PC that is available to you on your network

- Verify that the PC Server is not blocking your selected port through a firewall.

- Verify that the PDA’s Host IP and Host Port settings are correct and match the
server you are trying to attach to.

- Verify you are able to Ping the host PC from the mobile device using the Ping
Test utility outlined in Chapter 3.1.3

- Verify that you are able to ping your mobile device from the host PC.

6.3 Errors on PDA after Connection to TracerPlus Wireless Server

This could be the result of any number of issues, depending on the error presented. If the
suggestions below do not resolve the issue, please contact PTS Technical support for assistance.

Registration Status issues:

- Verify registration status or evaluation code status via the TracerPlus Wireless
Server PC application. This is available under Tools->Registration. The server
and PDA both require registration so it is possible that while the server is
registered, your individual PDA may not be. In this case, you need to either
purchase a PDA license or, if possible, extend your evaluation code via
Tools>Registration.

Session Selection issues:

- Verify that the selected Session is valid and enabled on the PC Server. This can
be checked via the menu ODBC Configuration screen. Be sure that the
enabled checkbox is selected. Be sure all settings are correct, check if DSN is
valid, and the database exists.

Data posting/update issues

- Be sure you are not violating the database primary key settings.
- Be sure that any data to be entered conforms to your database field properties.
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